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Read Me First
This ebook was published in October 2019 by alt concepts inc. It was 
written by Jason Snell and edited by Scholle McFarland.

This book helps you get started with Apple’s Photos app on a Mac, 
iPhone, and iPad. It focuses on importing libraries from older apps, 
managing your media inside Photos, and using Photos to edit and 
share your media with friends, relatives, and the world at large.

If you want to share this ebook with a friend, we ask that you do so 
as you would with a physical book: “lend” it for a quick look, but ask 
your friend to buy a copy for careful reading or reference. Discounted 
classroom and user group copies are available.

Copyright © 2019, The Incomparable Inc. All rights reserved.

Updates and More

You can access extras related to this ebook on the web (use the link 
in Ebook Extras, near the end; it’s available only to purchasers). On 
the ebook’s Take Control Extras page, you can:

• Download any available new version of the ebook for free, or buy 
any subsequent edition at a discount.

• Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.)

• Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview.

If you bought this ebook from the Take Control website, it has been 
added to your account, where you can download it in other formats 
and access any future updates. However, if you bought this ebook 
elsewhere, you can add it to your account manually; see Ebook Extras.

Click here to buy the full 165-page “Take Control of Photos” for only $14.99!

https://www.takecontrolbooks.com/class-copies/
https://www.takecontrolbooks.com/device-advice/
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Introduction 
In 2002, Apple introduced iPhoto as a way for us to save our photos on 
our Macs inside a “digital shoebox.” I’d owned a digital camera for 
three months, and had only a few hundred digital images. Over the 
years, as my photo collection grew, Apple revised iPhoto, always trying 
to stay in front of the onslaught of thousands of digital photos accumu-
lated over a lifetime—at least the lifetime of my two children. 

By 2014, enough was more than enough. Apple decided it needed to 
start from scratch and ditch iPhoto and replace it with a single applica-
tion, which would be called—in the prosaic style favored by Apple for 
its iPhone and iPad apps—Photos. This would allow Apple to unify 
(more or less) the photography apps it had created for its devices. 

In this book, I describe how to perform essential tasks with Photos on 
a Mac, iPhone, and iPad. Apple deploys some of the most powerful 
functionality it has developed—including its iCloud servers and its 
machine-learning technology—in the service of making your photo 
collection more accessible and discoverable. 

My daughter, whose birth was the motivator for my very first digital-
camera purchase, has just headed off to college. Her entire life has 
been chronicled with digital photos—tens of thousands of them at this 
point. That catalog, which spent time in several photography apps 
including iPhoto, now resides in my iCloud Photos, accessed via 
Photos on my devices. Photography is how we preserve the images of 
our lives; it’s important that we understand the software that allows us 
to organize, view, and share those images. That’s what you’ll learn 
here. 

The version of the book you are reading has been updated to reflect the 
changes in Photos version 5.0, which was released along with macOS 
10.15 Catalina, iOS 13, and iPadOS 13 in the fall of 2019. You can find 
an overview of the changes by reading What’s New in Photos. 

Thanks for joining me on this journey. Let’s get started! 
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Photos Quick Start 
This book explores Apple’s Photos app (in macOS, iOS, and iPadOS) by 
walking you through the most essential photo-management and 
editing tasks. You can read the chapters in any order. Click any link to 
jump to a topic. 

Find out what’s new: 
•	 Discover what you have to look forward to with Photos in 10.15 

Catalina, iOS 13, and iPadOS 13 in What’s New in Photos. 

•	 If you’re just now switching to Photos from Apple’s venerable 
iPhoto app, you can get a rundown of the differences in Switch from 
iPhoto. 

Import and manage photos: 
•	 Photos for macOS, iOS, and iPadOS can import files directly from 

your camera or memory card. Read Import Your Files into Photos. 
•	 On a Mac, you can switch between libraries to keep collections 

separate. See Manage Multiple Libraries on a Mac. 

Get organized: 
•	 Apple includes machine-learning technology in Photos that allows 

the app to identify objects, animals, and faces. Read Use Search to 
Find Your Photos to take advantage of this exciting feature. 

•	 Want to quickly round up all the photos of your kids taken with 
your DSLR within the last year? Take advantage of your valuable 
metadata in Define Smart Albums on a Mac. 

Perfect your photos: 
•	 Give photos a little extra “pop” by cropping, applying filters, and 

fixing red-eye and rotation problems. See Make Quick Photo Fixes. 
•	 Learn how to Make Edits to Your Files by removing unwanted 

details and applying adjustments, as well as editing with external 
apps if you prefer. 

7
 

Click here to buy the full 165-page “Take Control of Photos” for only $14.99!

https://www.takecontrolbooks.com/cart?add-to-cart=1247


  
         

          
        

       
 

           
            

  
            

             
            
  

           
   

   
             

        

           
       

          
     

           
             
          

     

Explore your collection: 
•	 Remember Christmas 3 years ago? Photos does. Peruse Photos-

generated collections of your photos, including a map of locations, 
associated people, and (in Photos for iOS and iPadOS) a 
customizable movie. Check out Unearth Old Photos with Memories 
for much more. 

•	 Get a handle on how Apple automatically identifies the people in 
your photos, as well as how to put names to faces in Name and 
Search People. 

Connect with other devices: 
•	 Thanks to the cloud, you can access your entire photo library from 

any device you own. But some Mac users may need to change the 
way they think about managing their photos to make it work. Read 
Sync with iCloud Photos. 

•	 Admire your favorite photos on your big-screen TV when you View 
Photos on Apple TV. 

Show off your photos: 
•	 Don’t let your photos stay locked up on your Mac. Learn the easiest 

ways to Share Your Files with others using social media and more. 

•	 If your desired method of sharing your photos involves getting them 
out of Photos, try Export and Resize Images. 

•	 Turn a special event’s photos into a beautiful movie with its own 
soundtrack. See Make Slideshows in Photos. 

•	 For all the convenience of digital photos, there’s still nothing quite 
like holding an image of loved ones in your hands. Discover how to 
use new third-party extension apps to design printed calendars and 
books. See Build Books and Calendars. 
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What’s New in Photos 
In macOS Catalina, iOS 13, and iPadOS 13, Photos has grown and 
changed. Here are the highlights of the biggest changes in the new 
versions of Photos. 

New Tab-Based Library Browser
 

The biggest change to Photos this year is the addition of an entirely 
new method of browsing your library. Your library is now segmented 
into curated Days, Months, and Years views, along with an All Photos 
view that’s more like what you had before. Learn more in Navigate the 
Photos Interface. 

Changes in Photos on iOS and iPadOS 
There were some major changes in iOS 13 and iPadOS 13 this year: 

•	 There are new photo-editing effects and a new sliding-icon interface 
to manage it all. See Make Edits to Your Files for more. 

•	 Photos is much more capable at modifying individual video files. 
You can rotate, adjust, and apply effects, as detailed in Edit a Video 
on an iPhone or iPad. 

Changes in Photos on macOS
 

The Mac version of Photos added a few features that were previously 
available only on an iPhone or iPad: 

•	 You can now create a Memory movie on a Mac. Learn how in Edit a 
Memory Video. 

•	 You can now search multiple categories at once from the search box. 
See Use Search to Find Your Photos. 
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Switch from iPhoto 
It’s been several years since Apple officially declared iPhoto a dead app 
and replaced it with Photos—macOS Catalina can’t even run it. Still, 
you might be one of the last holdouts or you might have old iPhoto 
libraries sitting around with no way to access them anymore. I under-
stand—photo libraries may be the most precious troves of data on our 
computers, and the prospect of moving them to a new app can be 
daunting. 

The truth is, Photos is really just an expanded and updated version of 
iPhoto with a new name. A few organizational features have been lost, 
the interface is more refined, deep connections to iCloud and Apple’s 
machine-learning technology have been added, and the app feels 
faster. Photos can import your iPhoto library (see Import from iPhoto 
into Photos). iPhoto’s star ratings have been demoted to keyword 
status, flagged items are now Favorites, and iPhoto Events are now just 
another kind of photo album. Photos also offers numerous improve-
ments to iPhoto, including expanded editing tools and direct integra-
tion with iCloud. 

With a little time, iPhoto users should be able to settle in comfortably. 
In this chapter, I show you how to migrate over. 

Tip: For a closer look at the pros and cons of switching, see Rob 
Griffiths’ article “An in-depth look at moving from iPhoto to Photos.” 

Import from iPhoto into Photos
 

Photos directly imports iPhoto libraries, and does so while keeping 
them intact—more or less (Figure 1). Because the features of Photos 
don’t align precisely with those in iPhoto, some information from 
iPhoto ends up in unexpected locations. 
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Figure 1: An iPhoto library (left) migrates to Photos (right). 

You’ll need to get used to the changes in Photos—and be prepared to 
change your approach to organizing your media—but Apple has 
worked to make the migration process as painless as possible. 

Import Automatically 
The first time you launch Photos, it searches your system for iPhoto 
and Aperture libraries. If only one library fits the bill, it imports that 
library. Otherwise, it opens the Choose Library dialog (see Manage 
Multiple Libraries on a Mac). Choose a library from the list, and 
Photos prepares the library for import. 
In some cases, macOS may import your iPhoto library before you ever 
open Photos. Don’t worry—iPhoto warns you if this has happened, and 
you can delete that unedited Photos library and re-import from iPhoto 
at any time without penalty. 

Import Any Time 
If you’re not ready to import your library right away, you can do so 
later. Hold down Option when you launch Photos to bring up the 
Choose Library dialog. From that dialog, you can select to import any 
iPhoto or Aperture library. 
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Import Your Files into 
Photos 

If you use iCloud Photos, the images you take on your devices automat-
ically sync to all your other devices (see Sync with iCloud Photos), but 
sometimes you may end up taking photos with a standalone camera, or 
get handed a memory card or USB device loaded up with images or 
videos. Photos can handle these classic methods, of course (Figure 4). 

Figure 4: When you attach a camera or insert a memory card, 
Photos displays the contents in the Import pane. 

Tip: For information about importing an entire library into Photos, 
see Import from iPhoto into Photos. 

You probably want to import your files directly into Photos, though 
there are some instances where you might prefer to import them into 
your device’s file system first and then add them to Photos later. If you 
plan to modify your images in some way before Photos ingests them, or 
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(on a Mac) if you’d prefer to manually manage where your files are 
stored, use the second approach. 

Import via USB
 

If you’re shooting photos (or capturing video) with a standalone 
camera, or with an iPhone or iPad that isn’t syncing with iCloud, you 
get your files into Photos by attaching the device or its memory card to 
your Mac, iPhone, or iPad. 

When you attach a device that your Mac, iPhone, or iPad registers as 
one containing photos and/or videos, your device appears automatical-
ly in the Devices section of the sidebar (Mac) or an Import tab appears 
on the toolbar (iPhone or iPad). 

Skip Photos Already in Your Library 
When you attach a device, Photos scans its contents and compares 
them to its current library. If Photos finds the same images in both 
places, it collects these items at the very top of the Import pane, 
marked as Already Imported (Figure 5). Below that, it shows photos 
that aren’t yet in the library, labeled as New Items. 

Figure 5: Photos points out items you’ve already imported into its 
library. 
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Manage Multiple Libraries 
on a Mac 

Most people will probably use a single library with Photos. But if you’re 
using a Mac and want to keep strict separation between different 
media collections, it’s easy to create multiple libraries in Photos and 
switch between them (Figure 12). 

Figure 12: Two different Photos libraries, with entirely different sets 
of media. 

Reasons to Have Many Libraries 
There are plenty of scenarios that might lead you to want more than 
one library: 

✦ Create one for each client, if you’re a freelance photographer. 

✦ Keep your work photos separate from the family stuff. 

✦ Let your kids mess with their photos without trashing your library. 

✦ Separate the files you want to sync to iCloud from ones you don’t. 

Add a New Library
 

Here’s how to create a new Photos library: 

1. Hold down the Option key as you open Photos. 
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2. In the Choose Library dialog that appears (Figure 13), click the 
Create New button. 

Figure 13: Hold down Option while opening Photos to see the
 
Choose Library dialog.
 

Photos asks you to choose where on your Mac’s drive you want to save 
the new library file. 

Switch Between Libraries
 

Hold down the Option key as you open Photos. In the Choose Library 
dialog, do one of the following: 

•	 If one of the listed libraries is the one you want to open, select it and 
click the Choose Library button. 

•	 To open a Photos library that isn’t listed, click Other Library. 

Note: The Choose Library dialog lists any importable library it can
 

find—the app searches your Mac for any Photos libraries as well as 

not-yet-imported Aperture and iPhoto libraries.
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Navigate the Photos 
Interface 

The main focus of the Photos interface is the Photos view, which in 
macOS Catalina and in iOS and iPadOS 13 is populated by a curated 
selection of your photos. Mac users can navigate to other views by 
clicking on items in the sidebar; for iPhone and iPad users those views 
are in the other tabs at the bottom of the screen. Don’t worry, though, 
the All Photos view still shows you everything (Figure 17). 

Figure 17: While the main Photos interface is broken up into curat-
ed Years, Months, and Days views, you can still see all your photos 
in the All Photos view. 
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Browse Your Library Through Time
 

The Photos view organizes your Photos library through time, with 
older photos at the top and the newest ones at the very bottom. At the 
top of the screen is a set of tabs that let you choose whether to view 
Years, Months, Days, or All Photos. (You can also pinch, tap, or 
double-click to zoom in and out of the three different view levels.) 

Here’s what the different views show: 

•	 Years: Tiles depict single years in your library (Figure 18), with 
an image or video selected from the same time of year as the present 
day. In the summer, you see lots of beaches. In the fall, a bunch of 
kids going back to school. 

Figure 18: Revisit this month in past years with the Years view. 

•	 Months: Tiles appear in a couple of sizes (Figure 19), segmented 
by Photos in an attempt to detect discrete events based on time and 
location. An event might just be a single day at home, or it might be 
a weeklong trip to Europe. Apple uses a massive database of loca-
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Sync with iCloud Photos 
While Photos works fine as a standalone image library, it’s built to 
connect with Apple’s online service, iCloud. With iCloud Photos, all 
your devices can view items stored in a single online library—and add 
new items to it—giving you access to every item in your media collec-
tion from any device (Figure 29). 

Figure 29: Check the iCloud Photos box in Photos > Preferences > 
iCloud to sync with iCloud. 

Uploading your Photos library to iCloud adds convenience and a 
measure of safety to your photo collection, but there are numerous 
complications to this process, too. 

The Cost of Cloud Storage 
As of this writing, every Apple ID comes with 5 GB of free iCloud 
storage. 50 GB of iCloud space (including not just your photos but 
your iPhone and iPad backups as well as iCloud Drive files) costs 
$0.99 per month, 200 GB costs $2.99 per month, and 2 TB costs 
$9.99 per month (To check the latest pricing and rates for different 
countries, see Apple’s iCloud storage plans and pricing page.) 

At the high end, that’s at parity with Google Drive and Dropbox. 
Amazon Photos now offers unlimited photo storage free for Prime 
members, and Google Photos offers free unlimited storage space—so 
long as your photos are limited to 16 megapixels and your video files 
to 1080p. 

Set the System Photo Library on a Mac 

iCloud syncing works only with a single library on your Mac, which 
Apple refers to as the System Photo Library. It’s generally the first 
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library that you opened when you started Photos. You can have as 
many libraries as you like (see Manage Multiple Libraries on a Mac), 
but only one can sync to iCloud. 

To change the System Photo Library: 

1.	 Hold down the Option key and launch Photos. 
2.	 Select the library that you want to sync via iCloud, and click Choose 

Library. 
3.	 Choose Photos > Preferences > General. 
4.	 Click the Use as System Photo Library button (Figure 30). 

Figure 30: Click Use as System Photo Library to make your current-
ly open library iCloud eligible. 

Start Syncing With iCloud Photos
 

When you sync with iCloud Photos, you also have to choose which 
items are retained on your device’s local storage. Here are the details. 

Turn On iCloud Photos 
To turn on iCloud Photos on a Mac, choose Photos > Preferences > 
iCloud and select the checkbox next to iCloud Photos. Photos 
immediately begins uploading the entire contents of your library to 
iCloud. On an iPhone or iPad, toggle this setting on in the Photos 
section of the Settings app. 
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Use Search to Find Your 
Photos 

I used to manually tag and keyword all my digital photos and curate 
photo albums for every major life event, but the number of shots I took 
kept accelerating, and at some point I just gave up. I’m not alone—but 
advanced computer vision technology has come to the rescue! 
All the images in Photos libraries are scanned millions of times with 
machine-learning algorithms to identify more than 4,000 different 
scenes or objects as well as unique faces (see Name and Search People 
for more on face-detection). This makes the Search feature in Photos 
incredibly powerful. Want to find a photo featuring a dog? Just type 
dog in the search box. The automatically generated Dog category 
provides you with possibilities (Figure 35). And that’s just the begin-
ning. While you may want to keep manually organizing your photo 
library, you may find that the search features in Photos make that 
labor unnecessary. 

Figure 35: Photos can do tricks like identify dogs in photos. (No-
body’s perfect, though—it also found a few cats.) 

Embrace the Search Box
 

Some people use search boxes habitually. Others see them as a last 
resort. If you’re in the latter camp, you need to break from tradition 
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when you use Photos. The Search feature in Photos is terrific. You can 
quickly search keywords (Figure 36), titles, or descriptions. Enter a 
year, or a month and a year, and you see all the photos taken during 
that time. 

Figure 36: Type the name of a location (here, the island of Kauai) 
to see all the pictures you took there. 

I rely on the Search feature for navigating my library of more than 
86,000 photos, and I highly recommend it. When in doubt, use the 
search box! 

On a Mac, if you don’t see the search box in the upper-right corner, 
back out to a broader viewing level, such as the main level of an album. 

On an iPhone or iPad, search by tapping on the Search tab in the 
bottom right corner of the screen. 

Quickly Jump to Dates 
Type a month and year combination to quickly see all photos taken
 

on that date. So, for example, I enter August 2004 to see all the
 

images from the month my son was born.
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Name and Search People 
Photos performs 11 billion computations on every photo to analyze its 
contents for faces, scenes, and objects. But while Photos is good at 
recognizing faces, it’s terrible at putting names to those faces. Unless 
you’ve been diligent about adding everyone whose picture you take to 
the Contacts app (complete with a picture that Photos can use to 
identify them), you need to do some work in the People album (Figure 
43), located in the Library section of the sidebar on a Mac and in the 
People & Places section of the Albums view on an iPhone or iPad, to 
teach Photos who’s who. 

Figure 43: The People album is a catalog of familiar faces, and it’s 
where you teach Photos who is who. 

Find All Photos for a Person
 

The People album contains all the faces Photos has identified and 
connected to a name. If you want to find photos of a specific person, 
this is the place to go—just select an item to see all the photos that 
Photos has matched to that face. You also find a map showing all the 
places where photos of this person were taken, a list of other people 
who are frequently seen with this person, and even automatically-
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generated Memories (see Unearth Old Photos with Memories) that this 
person appears in (Figure 44). 

Figure 44: The page for my friend John lets me browse all pictures, 
locations, and Memories he appears in, and even shows me other 
people he’s usually seen with. 
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Unearth Old Photos with 
Memories 

Memories (Figure 51) present you with collections of photos and 
videos based on times, place, or theme, so you don’t have to do the 
work to gather everything together. 

Figure 51: The Memories view shows collections of images and 
videos that Photos thinks you might like. 

On a Mac, the Memories view is located under Library in the sidebar. 
On an iPhone or iPad, it’s on the For You tab. It contains a scrollable 
list of labeled tiles. Memories are organized automatically by Photos 
based on a few different concepts: the recent past (“Best of Last 
Month”), this same time in a previous year (“On This Day”), locations 
(“Kauai”), and other machine-learning-related themes (“In Nature”, 
“Around the Table”, “Fluffy Friends Over the Years”). It may seem a bit 
scattershot, but the idea is to help rediscover photos that you’d never 
otherwise revisit. 

What’s In a Memory?
 

Every Memory begins with a large header image and text describing 
the Memory (Figure 52). This is actually a video you can customize. 
(See Edit a Memory Video, later in this chapter.) 
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Figure 52: At the top of a Memory is a large header that’s actually a 
customizable video slideshow. 

Below this is an automatically generated summary of what Photos 
considers the “best” images from this Memory. Select Show More to 
see all the photos and videos that are a part of the Memory. 

A Memory page can also feature groups and people who appear togeth-
er in this Memory (Figure 53), a map of locations represented within 
the Memory, and related Memories. 
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Manually Manage Your 
Photos 

Apple knows most of us don’t have a lot of time to organize our photo 
libraries. That’s why Photos uses machine learning to deeply analyze 
each image to figure out its contents. 
But not everyone is ready to embrace the power of machine learning 
and let an algorithm make decisions about personal memories. That’s 
why Photos also contains a set of simple organizational tools that let 
you embed additional meaning into the images you’ve captured. 

Play Favorites
 

Some of us like to precisely quantify things. I knew a kid in high school 
who actually rated every movie he watched on a five-star system. (He 
grew up to be a movie critic—true story!) But most of us can’t be 
bothered with complex ratings systems, so Photos uses a simpler 
approach: Favorites. 

In All Photos and album views, all your Favorites appear with little 
white hearts in their bottom-left corner (Figure 56). Awwww. 
(There’s even a subtle drop shadow, so if that corner of your photo is 
white, you can still see the heart.) 

Figure 56: Find the fave: it’s the one with the white heart in the 
bottom-left corner. 
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Click Favorites in the sidebar to see just your very best shots, as judged 
by you (Figure 57)! 

Figure 57: If I had a favorite view of my photos, it would probably 
be quite similar to the Favorites view. 

Make a Favorite 
There are plenty of ways to mark a photo as a Favorite on a Mac: 

• Select an image and then click the heart icon located toward the 
right side of the toolbar (Figure 58). 

Figure 58: Show your love with the heart icon. 

• Select an image and press the Period (.) key. 

• Hover your pointer over the image and click the heart that appears 

• Select an image and choose Image > Add to Favorites. 

• In the Info window (press ⌘-I), click the heart in the upper-
right corner. 

To favorite a photo on an iPhone or iPad, touch and hold on the image 
and choose Favorite from the pop-up menu. If you’re viewing the 
individual image, you can also tap the heart icon on the toolbar. (If 
the heart is filled in, the image is already a favorite. You can un-fa-
vorite the photo by tapping it again.) 
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Make Quick Photo Fixes 
Photos has a bunch of simple tools that can improve your images 
quickly and without a lot of fuss. A few don’t even require you to enter 
image-editing mode. In this chapter, I focus on these “quick-fix” 
options. For more advanced editing, see the next chapter, Make Edits 
to Your Files. 

To edit your photos, enter Edit mode. On a Mac, select an image and 
press Return. (If you’re already viewing a single image, you can either 
press Return or click the Edit button in the top right.) Move between 
different photos with the arrow keys without leaving Edit Mode. When 
you’re done, click Done to exit the view. On an iPhone or iPad, tap to 
open a single image and tap Edit. 

When you’re in Edit mode, the entire Photos interface changes. You’ve 
got access to three different sets of editing tools, which are displayed as 
tabs on a Mac and as icons on an iPhone or iPad: Adjust , Filters , 
and Crop (Figure 67). In this chapter, we use features in each of 
these three tabs. 
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Figure 67: The Edit pane consists of a large image preview, tabs, 
and a strip of controls down the right side. 

Tip: Two of the quick-editing features in Photos are so quick, they 
don’t even require you to enter editing mode on a Mac. These items 
appear on the toolbar in the top right of the Photos window. Rotation 

is accessible at all times, and Auto Enhance is accessible after 
you double-click any photo. You can also press ⌘-E at any time to 
auto-enhance a selected photo. 

Use Auto Enhance
 

While Photos gives you lots of tools to tweak your images very 
carefully, it also offers a sophisticated auto-enhance feature, which you 
can activate by clicking the Enhance icon , which is always visible on 
the toolbar on a Mac, and accessible from the Adjust controls  on an 
iPhone or iPad. When you Enhance an image, Photos analyzes it and 
makes its best guess about the proper levels, color, and more (Figure 
68). 
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Make Edits to Your Files 
Basic adjustments of the kind I described in the previous chapter, 
Make Quick Photo Fixes, are often all you need to make your photos 
come to life. But sometimes you need to take total control over the 
situation. 

On a Mac, select an image and press Return (or if you’re viewing a 
single image, click the Edit button in the top right) to enter Edit mode. 
On an iPhone or iPad, tap to view an image and then tap the Edit 
button. Then click or tap Adjust , which is an icon on an iPhone or 
iPad and a tab on a Mac. You see numerous tools you can use to make 
your images look their best (Figure 74). 

Figure 74: Exterminate all your images’ flaws with the Adjust tab of 
the Edit view. 

Learn to Adjust Your Photos
 

The adjustment controls in Photos are slightly different on a Mac and 
on an iPhone or iPad. On a Mac, you find 13 different controls on the 

102 

Click here to buy the full 165-page “Take Control of Photos” for only $14.99!

https://www.takecontrolbooks.com/cart?add-to-cart=1247


             
          

         
         

      
          

     

            
           

              
            

           
         

             
           

             
        
 

right side of the window. When you hover over them, you see that 
many offer an Auto button to automatically apply basic adjustments, 
as well as an undo arrow . Click the disclosure triangle to the left of 
any item to see the controls that live underneath (Figure 75). 

Figure 75: Many adjustment options on a Mac have a primary 
control (visible once you click the disclosure triangle) made up of 
component options you can display by clicking another triangle. 

Many, but not all, of the adjustment controls offer an interface where 
you drag a control across a horizontal bar. The center position general-
ly means no effect is applied, while dragging to the right or left applies 
an effect positively or negatively. For example, as you slide the Color 
control to the right, your image becomes increasingly saturated. If you 
slide it to the left, the color gradually drains away. 

On an iPhone or iPad, the controls vary depending on your device and 
its orientation. In Adjust mode (Figure 76), 16 controls display as 
icons inside circles either on the right side of the screen (iPads and 
iPhones held horizontally) or at the bottom (iPhones held vertically) 
(Figure 77). 
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Share Your Files 
What good are photos and videos if you can’t share them with friends? 
Traditionally, sharing photos meant sending prints or making albums. 
You can still do that—see Build Books and Calendars—but sometimes 
you want sharing to be more immediate. iCloud Photo Sharing lets you 
share an entire album that others can update and comment on (see 
Share Using Shared Albums). And if your desired sharing method 
requires that you get your files out of Photos, you can do that too (see 
Export and Resize Images). 

Transfer Your Files Directly
 

Sometimes you just want to get your photos or videos right out of 
Photos and into the hands of another person or another app. There are 
lots of different ways to do this: 

•	 Drag and drop: On a Mac, the most direct way to do this is to 
select a file or files and drag them out into Finder or other apps. In 
older versions of macOS, Photos didn’t play well with other apps in 
terms of dragging and dropping files, but in Catalina it works pretty 
much everywhere. You can also drag and drop items from Photos 
into other apps using multitasking on the iPad. 

•	 Other apps: You can pass your photos directly to another app by 
tapping on the Share icon and choosing that app, whether on a 
Mac, iPhone, or iPad, though there are far fewer options on a Mac. 

•	 AirDrop: If you’re trying to directly transfer files to a device that’s 
near yours (whether it’s a Mac, iPhone, or iPad), Apple’s AirDrop is 
the best method to use. Click or tap the Share icon, choose Air-
Drop, and pick a target device. The owner of the target device is 
prompted to accept the file transfer. (Your recipient may need to 
adjust their AirDrop settings in order to be visible on your device.) 
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•	 iCloud Photo Sharing: If you have this feature turned on, click or 
tap the Share icon and choose Shared Albums (Mac) or Add to 
Shared Album (iPhone and iPad) to add a photo to any of your 
shared albums. (See Share Using Shared Albums, later in this 
chapter.) Images shared using this feature are reduced to 2048 
pixels on the longest edge. 

Tip: Photos offers a few different ways for you to select more than 
one photo for use with the Sharing menu. On a Mac Shift-click or ⌘-
click to select a batch of photos. On an iPhone or iPad, tap Select and 
then tap or slide your finger on photos you want to select. 

Export and Resize Images
 

Sometimes you need to export an image or collection of images, but 
don’t want or need them at full resolution. (This often happens when 
I’m uploading a photo as an avatar or background image for a social-
media service, where there are very specific file-size and image-size 
constraints.) This is easy to do on a Mac and more complicated on an 
iPhone or iPad. 

Export and Resize on a Mac 
Photos for Mac’s Export command is powerful. Here’s how to use it: 

1. Select the photos. 

2.	 Choose File > Export > Export X Photos. (Where X is the number of 
photos.) 

3.	 Choose whether to export the images in JPEG, TIFF, or PNG 
format; whether or not to embed metadata such as titles, keywords, 
and locations; and which file naming convention to use. 

4.	 To resize the images or set a compression level, click the disclosure 
triangle by the Photo Kind pop-up menu to reveal those options. 
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View Photos on Apple TV 
Your living room is a natural place to share photos, and your big high-
definition TV set can be an excellent canvas. If you have a fourth-
generation Apple TV or Apple TV 4K connected to your set, you can 
view your iCloud Photos, as well as Albums and Memories, in the 
Apple TV Photos app (Figure 109). 

Figure 109: The Apple TV Photos app gives you access to your 
iCloud Photos library, Memories, and albums. 

Scroll Through Photos
 

The Photos app on the Apple TV is designed to show off your photos 
and videos, not to let you make edits. The Photos pane displays the 
entire contents of your iCloud Photos Library separated into Moments, 
with the newest on top. 

Apple TV would be the perfect platform for the new curated Years/ 
Months/Days view found in today’s Photos app. Unfortunately, in tvOS 
13 the Photos app is unchanged—it only displays the All Photos view. 
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To view an image full screen, select the photo with the Siri Remote and 
click. From this view, you can swipe left and right to move to the next 
and previous photos in your library. 

Tip: The Apple TV can play back the video version of a live photo. 

Swipe up to display the date and time the photo was taken (Figure 
110). Swipe back down to zoom back to full size. 

Figure 110: Swipe up on a selected photo to see the date and time 
the photo was taken. 

Note: Photos not showing? Your teen’s photos showing instead of 
yours? Read Use iCloud Photos on the Apple TV for help. 

View Collections of Photos
 

You can do more than just scroll through a library on the Apple TV. 
You’ve also got access to collections of photos, from Memories to 
Albums. 
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Make Slideshows in 
Photos 

I can’t go to a school function without seeing at least one slideshow. 
Photos provides eight different slideshow themes (Figure 113), and if 
you’re the type who wants your slideshows just so, you have a lot of 
power to control exactly how yours behave. 

Figure 113: The Vintage Prints theme may be my favorite of the 
Photos slideshow themes. 

This chapter begins by talking about the slideshow options in Photos 
for the Mac; for information about the iPhone or iPad, read Make 
Slideshows on iOS or iPadOS, at the end of the chapter. 

Tip: Don’t forget that Photos can also automatically generate movies, 
which are very much like slideshows, for every Memory as well as 
many events in the Months and Days views. Click or tap the Play icon 

at the top of any Memory. In Month and Day views, click or tap 
the More icon on a tile and choose Play Movie. 
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Create a Slideshow on a Mac
 

To create a Slideshow select a group of photos and choose File > 
Create > Slideshow > Photos. Give your slideshow a name, and click 
OK. A new entry appears in the My Projects section of the sidebar. 

In the slideshow editor that opens, you can organize the images, 
choose a theme and music, and determine how long your slideshow 
lasts, as I describe next. 

Choose a Theme 
Click the Theme Picker icon at the right and then click a theme 
name. You can re-order the images in all themes by dragging their 
thumbnails around in the strip at the bottom of the window—drag the 
rule above the thumbnails up a bit if they’re too small (Figure 114). 

Figure 114: Choose a theme from the list at right. You can drag 
around the small images at the bottom of the screen to re-order the 
Slideshow. 

142
 

Click here to buy the full 165-page “Take Control of Photos” for only $14.99!

https://www.takecontrolbooks.com/cart?add-to-cart=1247


             
           

            
   

            
           

            
        

             
             

 

     
             

         
           

     
         

            
          

Build Books and Calendars 
My family has a tradition of curating our very best photos and creating 
annual calendars and books. These physical products are great ways to 
keep our photos in view throughout the year, even when we aren’t 
staring at a device. 
On a Mac you can create books and calendars directly within Photos 
via third-party app extensions available for download in the Mac App 
Store. These free apps allow you to create projects based on your 
Photos library and order them from right within Photos. 
The story’s not as strong on an iPhone or iPad, though a recent arrival 
makes it more plausible to create and order books right from your iPad 
or iPhone. 

Design Books with Mimeo and Motif 
There are two apps that really excel at letting you build paper books 
and calendars within Photos on a Mac: Mimeo Photos and Motif, both 
free. I describe the process of building books in both of them below. 

Build with Mimeo Photos on a Mac 
I’ve been very impressed with Mimeo Photos (Figure 122). In gener-
al, I found it to be a suitable replacement for Apple’s own book-build-
ing tool, with some features that surpass the ones that Apple previous-
ly offered. 
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Figure 122: Mimeo Photos lets you build books within Photos, and 
offers some features that Apple’s implementation never did. 

To create a project using Mimeo Photos, first download the app from 
the App Store. After you launch the app and give it permission to 
access your photos, you can start a new project by selecting images or 
an album in Photos and then choosing File > Create > Book > Mimeo 
Photos. 

Choose the type of book you’d like to create (Mimeo offers six styles of 
hard- and softcover books). Click Create, select from one of more than 
50 themes, and Mimeo generates an automatic layout based on the 
images you add to the project. (I found myself deleting all those pages 
and then slowly building my own.) 

In the sidebar on the right side of the window, click Layout to view all 
the optional layouts for a page (Figure 123). Mimeo provides dozens 
of layout designs based on how many photos you want on a page or 
spread. 
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About This Book 
We hope that you found this book both useful and enjoyable to read. 
We welcome your comments and questions in individual chapters. You 
can also send us email. 

Ebook Extras
 

You can access extras related to this ebook on the web. Once you’re 
on the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy 
a subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

•	 Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

•	 Find out if we have any update plans for the ebook. 

If you bought this ebook from the Take Control website, it has been 
automatically added to your account, where you can download it in 
other formats and access any future updates. However, if you bought 
this ebook elsewhere, you can add it to your account manually: 

•	 If you already have a Take Control account, log in to your account, 
and then click the “access extras…” link above. 

•	 If you don’t have a Take Control account, first make one by follow-
ing the directions that appear when you click the “access extras…” 
link above. Then, once you are logged in to your new account, add 
your ebook by clicking the “access extras…” link a second time. 

Note: If you try these directions and find that your device is incom-
patible with the Take Control website, contact us. 
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Why Take Control? We designed Take Control electronic books to help readers regain 
a measure of control in an oftentimes out-of-control universe. With Take Control, we also 
work to streamline the publication process so that information about quickly changing 
technical topics can be published while it’s still relevant and accurate. 

Our books are DRM-free: This ebook doesn’t use digital rights management in any 
way because DRM makes life harder for everyone. So we ask a favor of our readers. If you 
want to share your copy of this ebook with a friend, please do so as you would a physical 
book, meaning that if your friend uses it regularly, they should buy a copy. Your support 
makes it possible for future Take Control ebooks to hit the internet long before you’d find 
the same information in a printed book. Plus, if you buy the ebook, you’re entitled to any 
free updates that become available. 

Remember the trees! You have our permission to make a single print copy of this 
ebook for personal use, if you must. Please reference this page if a print service refuses 
to print the ebook for copyright reasons. 

Caveat lector: Although the author and alt concepts inc. have made a reasonable effort 
to ensure the accuracy of the information herein, they assume no responsibility for errors 
or omissions. The information in this book is distributed “As Is,” without warranty of any 
kind. Neither alt concepts inc. nor the author shall be liable to any person or entity for any 
special, indirect, incidental, or consequential damages, including without limitation lost 
revenues or lost profits, that may result (or that are alleged to result) from the use of these 
materials. In other words, use this information at your own risk. 

It’s just a name: Many of the designations in this ebook used to distinguish products 
and services are claimed as trademarks or service marks. Any trademarks, service marks, 
product names, or named features that appear in this title are assumed to be the property 
of their respective owners. All product names and services are used in an editorial fashion 
only, with no intention of infringement. No such use, or the use of any trade name, is 
meant to convey endorsement or other affiliation with this title. 

We aren’t Apple: This title is an independent publication and has not been authorized, 
sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses 
terms that are registered trademarks or service marks of Apple Inc. If you’re into that sort 
of thing, you can view a complete list of Apple Inc.’s registered trademarks and service 
marks. 
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